




































































































































































































































































TELECOMMUNICATIONS 

Use Hard Backspace When 
Correcting Mainframe Data 
When you're communicating with main­
frames, pressing Backspace will not cor­
rect data stored in the mainframe, even 
though it corrects your screen display. To 
remove the character you backspaced 
over on the mainframe as well , use 
Command-Backspace. 

Create Replacement Mac-To­
Mac Document 
The program supplies its own Mac-To­
Mac document with preconfigurecl termi­
nal settings. If you 've accidentally trashed 
this document, you can make a re place­
ment: 

Start by pulling clown the Settings menu 
and change the dialog boxes in Terminal 
Compatibility, and File Transfer, in that 
order. In the Terminal Settings, click New 
Line, Local Echo, On Line, Auto Repeat, 
and Auto Wraparound to On; in the 
Compatibility Settings dialog, choose 8 
bits per character, o parity, ro hand­
shake, and the baud rate the host com­
puter will use; in the File Transfer Settings 
dialog, choose XMoclem, Reta in Line 
Breaks, Word Wrap Outgoing Text, and 
Remote System equals MacTermina l. 
Leave all the other default settings, and 
save the document as "Mac To Mac." 

Avoiding System Hang 
Once in a while, MacTerminal will hang 
up after the host computer has answered 
the call. If you' re using a Hayes-compat­
ible modem, solve the problem by insett ­
ing a few conunas after the phone num­
ber. Each comma causes the modem to 

wait two seconds, allowing MacTerminal 
to registe r the fact that a connection has 
bee n made. 

MODEM 

Quiet Dialing 
If you're using a Hayes-compatible mo­
dem and don't wa nt to hea r all those 
beeps and clicks during dialing, turn off 
the speaker using the ATMO command. 
To turn it back on, type in ATMl. 

If You Can't Connect, Tell 
Your Modem to Wait Longer 
If you have tro uble connecting to an on­
line service, adjust the length of time the 
modem waits for a ca rrier signal before it 
hangs up and redials. The command 
ATS7=x sets the number of seconds the 
modem waits for a carrier. The default 
value for x is 20 seconds, but you can 
substitute a new number of seconds for x. 

When Call-Waiting 
Disconnects Transmissions 
If you have ca ll-wa iting and a modem, 
you can run inro a lot of inte rrupted 
te lecommunicatio ns sessions. A little­
known trick is to add '·*70'" on touch tone 
phones, or to dial 1170 on pu lse phones, 
just befo re the number to be dialed in 
your modem dial command. This disables 
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call-waiting. The tip may not work in all 
areas of the country. Ask your phone 
company for more derails. 

QuiCKMAIL 

QuickMail Tips 
QuickMail Power CE Software's Quick­
Mail2.0, on irs way to becoming the most 
popular electronic-mail program for the 
Macintosh, is an efficient system- espe­
cially if you use some of these hints. 
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l.Tired of scro lling through a long di­
rectoJy every time you want to send 
a message to the person at the bot­
tom of the list? An easy way to force 
names to the top of the list is to use 
QuickMail 's Group command to 
create a group for the person (yes, a 
group can have just one member). 
Groups always appear at the top of 
the directo1y list. 

2. Want to know if someone read your 
message but don 't want to be inter­
rupted by a return receipt? Select 
Preferences from rhe QuickMail 
menu and cl ick on Log Handling. 
You can then enable your Mail Log. 
A Log ently shows who has read 
each message and when. 

3. Tired of sending the standard retrac­
tion "Ignore that last message - I 

forgot ro ... "?You can un-send a 
message that hasn't yet been read by 
using the Mail Log (but only if you 
have it enabled). 

4. Is QuickMail more like SnailMail for 
you? Here's how you can speed 
things up: In the Preferences dialog 
box, uncheck "Fill folders w hen 
opening" and disable your Mail Log 
(yes, we know that the last two tips 
tald you to use the Mail Log, but 
there we were ta lking about fea­
tures, and here we're talking about 
speed). Select and file new mes­
sages before reading them ; this 
moves them from the server to your 
own hard disk , speeding up access. 

5. Want to read a message you 've filed 
on your hard disk but don't want to 
log in to a Mail Center? Use QM Re­
mote. l t can open text files as well 
as QuickMail letters you 've filed. 

6. Too busy to be bothered with open­
ing your Quici<Mail? Often, the 
substance of a message can be 
ex pressed in the title, leaving intri­
cate deta ils for the body of the mes­
sage. Fo r example, instead of 
entitling amessage "Meeting 
Reminder'' and furnishing the date 
and time in the body of the message, 
you can entitle it "Meeting 10/ 22 1 
P.M." The title then acts as an effec­
tive reminder. You get all the 
information you need just by look­
ing at the QuickMail w indow. 
(I lowever, QuickMail truncates 
long message titles to fit into the 
main QuickMail w indow.) 
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7. Wish you could attach messages to 
Apple 's Alarm Clock DA? Use Quick 
Mail to address a message to your­
self and press the Delay button to 
postpone sending it until a specified 
date and time. 

• ' ... ! ..... ~· ' 

RED RYDER 

Disabling The 
Opening Screen 
Disable the opening screen by creating a 
dummy file (such as a text fi le w ith a 
single character in it) with the name RRJ$, 
then place it in the same folder in which 
you keep Red Ryder. 

White Night, the commercial upgrade to 
Red Ryder, has a menu option to disable 
the opening screen automatica lly. 

Turning The Mac Into 
A Mainframe Terminal 
You can use Red Ryder to turn your Mac 
into a mainframe terminal. The ability to 
write procedures simplifies logging on, 
and you can use the VT100 e mulation 
mode to produce a good fu ll-screen ter­
minal. The abili ty to define macro keys 
and have thirty of them available at a 
mouse click reduces the need to remem­
ber a jumble of mainframe commands. 
Perhaps the most convenient feature of all 
is the ability to copy from the screen by 

dragging the mouse. Combine this feature 
with the Paste to Modem command, and 
an IBM mainframe can be given a substi­
tute clipboard . 

Smooth Scrolling 
in TTY Mode 
Implement smooth scrolling in TTY mode 
using Reel Ryder. Just select VT100 Mode 
from the Special menu and then check the 
Smooth Scroll Mode box. Reel Ryde r will 
now produce smooth scrolling, even in 
TTY mode. This only works with version 
9.4 or higher. 

SMARTCOM II 

Capture Routine 
Saves Only Selected Text 
If you capture data to disk after receiving 
a transmission, highlight the text you 
want to save. The Capture routine saves 
only selected text, so if you save a file with 
nothing selected, nothing is what you'll 
end up with. 

Saving Text From 
The Capture Buffer 
If you acCidentally Close your document 
w ithout having saved the contents of the 
capture buffer, don't panic - yet. Try 
reopening a communications document. 
If you didn't use the Clear command from 
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the Edit n1enu to purge the buffer before 
you closed the transn1itted docun1ent, the 
text is still in the capture buffer, and it will 
appear in the docun1ent window. This 
won't work if you accidentally Quit 
Smartcom, though. 

Save And Save As ... 
Don't Save What's 
In The Capture Buffer 
The Save and Save As ... comn1ands only 
save the settings, not the data in the 
capture buffer. 

Put Your Work Files 
At Root Level On Disk 
Some earlier versions of Smartcom (2.1a, 
for example) can't recognize documents 
or applications that are in folders on 
anHFS system. Remetnber to put your 
work files on the root level before starting 
and you shouldn't have any problerns. 
(Version 2.2b corrects the folder prob­
len1s.) 
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Use Different System File 
When Using Sidekick 
If you'll be using Smartcom II with Side­
kick desk accessories, replace the System 
file with a new one. Hayes removed 
sorne resources from the Sn1artcom II 
System, and this can cause operating 
probletns with Sidekick. 

Forcing Smartcom 
To Use Text Protocol 
Instead of Sending a file, Paste it from the 
Clipboard. This makes Smartcom use a 
text protocol, even if MacBinary or Hayes 
Verification protocol has been selected. 
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fULL WRITE PROFESSIONAL 

Don't Try To Print 
With The Tall Adjusted 
Option Turned Off 
What you see on-screen isn 't necessarily 
what you get printed out whe n you 're 
using an Image Writer printer. When uying 
to print across the fu ll \vidth of the page 
when the Tall Adjusted o ption is off, you 
won't get the complete data on your 
printed page. The solutio n is to always 
print with the option turned on. 

If you don't want to reset the print options 
every time you open the application, you 
can use FuliWrite's stationery documents 
to save. 

First, start a new file. Check the Tall 
Adjusted on the Page Setup dialog box, 
then do a Save As ... and click on the File 
Format button. Then select Full Write Pro­
fessional Stationety. Name the document 
"FullWrite Stationery" and save it in the 
same folder as the Fu liWri te application. 
Remember to spell "srationety'' correctly! 

When you've fin ished, evety time you 
open FullWrire or ask it to create a new 
document, it will use the ··FuiiWrite Sta­
tionery" file as its defa ult. In addition to 
any font o r style settings you want to 

reuse, the stationery document will re­
member the Tall Adjusted setting, so you 
won't have to reset it agai n. 

MAcWRITE 4.5 

Save As Text When 
You're Exporting Files 
Wh ile there are a few word processors 
that can't recognize and open MacWrite 
files (most notably Microsoft Word), in 
general you' ll find it easier to export data 
to othe r programs or via modems by 
saving it as a Text Only file. The Text fo r­
mat is easily transmissible over ASCII data 
lines, and works well whe n you're u·ans­
ferring data to other types of computers. 

Numbering Pages 
Using The Page Icon 
The page icon in the Header automati­
cally begins numbering pages at 1. You 
can change this by selecting Set Page :r ... 
from the Format menu. To eliminate the 
number on the first page, select Title Page 
from the Format menu. 

Decimal Tabs 
Override Regular Tabs 
When you drag a decimal tab on to a 
regular tab, it automatically overrides the 
tab stop and turns it into a decimal tab. 
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The tab marker may look like a regular 
tab, but it w ill behave like a decimal tab. 
To get a good look at which kind of tab 
is placed on the ruler, click on the tab 
marker or move it around to reveal w hich 
tab it really is. 

Command-Backspace 
Restores Backspaced Text 
If you w ant to restore up to 50 characters 
o f text that you backspaced over, press 
Command-Backspace. This is especially 
useful if you want to insert a word without 
taking your hands off the keyboard. 

Hidden Spaces 
Can Affect Printouts 
Jf your text doesn't print correctly after 
you've set up tabs for columns, check 
problem lines or columns carefully to see 
if any spaces w ere mistakenly entered 
there. As soon as these inadvertent spaces 
have been erased, your printouts should 
come out spaced the way you meant 
them to look. 

Lack Of Disk Space Can 
Cause Printing Problems 
You can run into trouble uy ing to print 
documents if there isn't enough space on 
the disk to save the document to the buf­
fer. Jf your disk is too fu ll to print. either 
delete some files or else transfer the docu­
ment to a less-overburdened disk. In a 
pinch, you can print a few pages at a time. 

Identifying 
Hookup Problems 
If you're getting the message that your 
document can't be printed, tty again, 
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watching the dialog box while the Mac 
tries to print. I f the Mac displays the 
message '·Looking for the ImageWriter/ 
LaserWriter'' for longer than usual and 
then tells you it can't print your docu­
ment, check all the connections to be sure 
the printer is hooked up correctly. 

When MacWrite Says It Can't 
Print A Document 
If you tty to print a document from the 
desktop, only ro be told tl1at you can't, 
launch MacWrire by double-clicking it. 
Then, close the new file and open the one 
you want to print. 

' 
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MAcWRITE 4.6 

Using Cursor Keys Instead 
Of Mousing Around 
MacWrite 4.6 gives you the option of 
using cursor keys instead of tl1e mouse to 
perform various functions. 

To go to a point in a text passage. just 
use the Arro\\' keys: 

To go to the beginning of a line, press 
Command-Right Arrow Key or Com­
mand-Left Arrow Key to go to the 
beginning of a line. 

To go to the bottom o r top of a page, 
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press Command-Up Arrow or Com- Numeric Keypad 
mand-Down Arrow. Commands 

There are a few keyboard commands 
To move the cursor left or right one which can be useful: 
word at a time, press Option-Right 
Arrow or Option-Left Arrow. 

To move up or down a paragraph at a 
time, press Option-Up Arrow or Op­
tion-Down Arrow. 

Select a paragraph, letter, word or page 
by pressing Shift simultaneously with 
the above instructions. 

New Keyboard Sequences 
When going from Mac write 4.5 to 4.6, 
there are new keyboard sequences. The 
most noticeable is the use of the Cursor 
Keys. 

To go to a point in a text passage, just 
use the Arrow keys. 

To go to the beginning of a line, press 
Command-Right Arrow key or Com­
mand-Left Arrow key. 

To go to the bottom or top of a page, 
press Command-Up or Command­
Down Arrow key. 

To go left or right a word at a titne, 
press Option-Right or Option-Left Ar­
row key. 

Finally, to go up or down a paragraph 
at a time, press Option-Up or-Down 
Arrow key. You can select a paragraph, 
letter, work, or page by combining 
these key combinations with the Shift 
key. 

The asterisk (C') on the numeric keypad 
helps to highlight characters and words. 
If you select a few characters with the 
n1ouse and discover that you missed a 
letter or two, the asterisk key extends 
the selection by one character for each 
press. 

Extend your selection rapidly by hold­
ing down the asterisk. 

Comtnand-* (using the asterisk from 
the nun1eric keypad) selects the entire 
line from the position of the cursor to 
the end of the line. 

Option-* (using the asterisk from the 
keypad) selects one word at a time. 
The + key causes the selection to be 
made to the left of the cursor instead of 
to the right. 

The = and I keys highlight all of the line 
above or below, up to the point di­
rectly above or below the cursor. 
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MAcWRnE 5.0 

When The Spell-Checker 
Tells You The 
Clipboard Is Too Large 
If your Mac doesn't have a lot of extra 
RAM, sometimes running MacWrite S.O's 
spelling checker might result in the mes­
sage, "The clipboard is too large to trans­
fer for use by desk accessories or other 
applications." You won't be able to use 
the spelling checker again until you quit 
MacWrite and then reopen the program 
or file you want spell-checked. 

Picking Up 
Where You Left Off 
You can zip off to the insertion point you 
last saved off at by pressing Enter on the 
numeric keypad when you launch the 
file. 
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MAcWRITE II 

Nifty Smart Quote Feature 
The new MacWrite II has a nifty smatt­
quote feature that automatically converts 
the typewriter-style single- and double­
quote marks Clike"this") to the more-pro­
fessiona l - looking curly quotes. 

What do you do if you customarily use 
special foreign quote marks (such as 
guillemets in French, Italian, and Ger­
man)? You can change MacWrite II to be 
smart in any language by changing the 
SMQT resource with ResEdit. Open the 
resource and substitute the guillemets 
(both single and double) for the curly 
quotes. The keystrokes for<< and >> are 
Option-backslash and Shift-Option-back­
slash, respectively. The keystrokes for< 
and > are Shift-Option-3 and Shift-Op­
tion-4, respectively. Close ResEdit and 
save the changes you've made. ow the 
program will smartly insert the new types 
of quote marks as you type. 
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lEACH TEXT 

Placing Pictures In Teach 
Text Documents 
To place pictures in Teach Text docu­
ments, type Option-space where you 
want the picture to appear. The pictures 
must be stored as resources of type Pier 
in the document, copied there by ResEdit. 
The first Option-space is drawn as picture 
1000, the second as 1001 , etc. Leave 
enough blank lines after the Option­
space so d1e picture does nor cover the 
following text. To make the document 
read-only, change the file type to "ttro." 
Teach Text will display additional lines of 
credits while holding down Command­
option and selecting About Teach Text. 

WoRD 

Fast Save Uses Disk Space 
Microsoft Word has a Fast Save feature , 
which lets you save files relative ly quickly 
in exchange for greater disk-space con­
sumption. 

When the Fast Save option in the Save As 
dialog box is checked, Microsoft Word 
doesn't actually delete text or graphics 
that you remove from a document; it just 
skips over them when you're displaying, 
editing, or printing the document. So, 
files do n't get smaller when you delete 
things from them, and there is more 
overhead when you add new informa­
tion. When you choose Save As and un­
check the Fast Save check box, Microsoft 
Word actually erases all the deleted infor­
mation, so the file size should decrease. 

Spell-Checking Without 
Putting The Cursor At 
Document Top 
It's possible to run your spelling checker 
on a Word document without having to 
move all the way back to the beginning. 
First, select the entire document by moving 
the cursor to the left margin, where it 
changes into an arrow, and then click the 
mouse while pressing the Command key. 
When you run your spe lling checker, the 
entire dqcument will be checked in a 
single pass, without the annoying "Con­
tinue Check from beginning" message. 

Re-spacing Between Letters 
Word creates its own "normal" spacing 
between letters, based on the type and 
size of the font you're using. The problem 
is, sometimes the spacing created isn't 
exactly what you want. 

You can fix spacing between letters by 
selecting the text you want to change, 
choosing Character on the Format menu, 
and then selecting Expanded when the 
list of options appears. The program will 
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suggest an expansion amount in the By 
box. Override this suggested spacing by 
typing in any value from . 25 to 14 points. 
As you experiment with different results, 
you'll find the re-spacing that works best 
for you. 

Hiding Outline Headings 
People who compose a lot of outlines will 
be vexed to find that most headings must 
be left out of the finished product. You 
can delete the outline headings manually, 
but in a long document this can be 
extren1ely time-consuming and can hin­
der your efforts to revise the file later. 

A solution is to use Define Styles to create 
a style sheet on which all outline styles are 
based. Its style would be the same as 
Normal Text. Using Define Styles again, 
you can define each of the subsequent 
outline styles as being based on this 
"nonnal" style by entering that name in 
the "based on" box. Now, any changes 
you tnake to the definition of the base 
style will automatically be tnade to all 
outline styles. 

When you've finished composing and 
want to hide the outline, choose Define 
Styles and add Hidden Text to the style 
definition. All outline headc;; will vanish, 
unless you select Show Hidden Text. 
When you print documents created with 
this method, be sure Print Hidden Text 
isn't selected in the Print Dialog Box. 

Using Deflne Styles To 
Create Outline Styles 
A problem with Word's outlining capa­
bilities is that there is no Hide Outline 
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Headings comn1and. Often, one wants to 
compose in an outline, but n1ost headings 
must be left out of the finished product. 
You could delete the outline headings 
manually, but this can be very time con­
suming in a long document and can also 
hinder future document revision. 

The solution is to use Define Styles to 
create a style sheet on which all outline 
styles are based. You could call this "base 
style." Its style would be the same as 
Normal Text. Again, using Define Styles, 
each of the subsequent outline styles 
should be defined as being based on this 
Normal style by entering that name in the 
Based On Box. Now, any changes made 
to the definition of the base style will 
automatically be n1ade to all outline styles. 

When you have finished con1position and 
want to hide the outline, choose Define 
Styles and add Hidden Text to the style 
definition. All outline heads will vanish 
(unless you select Show Hidden Text). 
When you print, n1ake sure Print Hidden 
Text is not checked in the Print Dialog 
Box. 

"Auto-Date" Headers 
And Footers Can Be 
Copied Or Pasted 
Anywhere In A Document 
When you paste "auto date" headers and 
footers anywhere you want in your docu­
tnent, it continues to change automati­
cally whenever you start a new docu­
ment. This is especially useful if you work 
from templates. 
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The "auto-date" can be distinguished from 
text by using the Show Paragraph com­
mand (press Command-Y), which dis­
plays a dotted outline around all "auto­
dates." 

This also works for time and page num­
bering. As an extra shortcut, try pasting 
"auto-date" into your glossary and then 
add it to your Work menu. 

Key Strokes 
For line Formatting 
In Word, the Return key is used to end a 
paragraph, while Shift- Return is used to 
end a line without creating a new para­
graph. Shift- Return works fine as long as 
it isn't used in a justified paragraph. In the 
latter case, the line created with Shift­
Return is justified - something most peo­
ple will want to avoid. And you can avoid 
it by pressing Shift-Option-Return. 

This undocumented method of conclud­
ing a line is very useful for lines within a 
justified paragraph that, for example, are 
to contain only a tnathematical equation 
located at a center tab. It's also the only 
way to create the appearance of tnultiple 
justified paragraphs within a single box. 
Simply apply the boxed format to the 
paragraph and conclude each pseudo 
paragraph within the box with a Shift­
Option-Return. The concluding line of 
each "paragraph" will not be fully justi­
fied. 

Incidentally, the Shift -Option-Return sym­
bol that appears when Show 9f is active 
looks just like the Return symbol. 

Accessing The ImageWriter's 
Bullt-In Fonts 
Word provides an easy way to access the 
In1ageWriter's built-in fonts. 

In the lower-left corner of the Word 
window is a rectangular box that usually 
contains a shadowed page nun1ber. Click 
in this box and the word Code appears. 
This invites you to type a decimal (not 
hex) character code. Press Return to place 
that character in the text. 

The decimal code for the escape charac­
ter is 27 (this appears as a small box in 
your Word document). To access the 
variety of special fonts and font sizes built 
into the ImageWriter, simply add the 
escape codes at the beginning of your 
document and, if desired, at other points 
in your document. To do this, click in the 
Page box, type 27 in the place of Code, 
and press Return. Then in the main win­
dow, right after the small box that should 
now be showing, type the letter that will 
tell the Image Writer what to do. Here's a 
partial list: 

Esc n (Extended character set = 9 cpi) 
Esc N (Pica = 10 cpi) 
Esc E (Elite = 12 cpi) 
Esc p (Pica proportional) 
Esc P (Elite proportional) 
Esc e (Setnicondensed = 13.4 cpi) 
Esc q (Condensed = 15 cpi) 
Esc Q (Ultracondensed = 17 cpi) 
Esc A ( 6 lines per inch) 
Esc B (8 lines per inch) 

When you're ready to print, make sure 
that you have Typewriter selected in the 
Chooser. Do not choose ImageWriter. 
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Condensing The Space 
Between Italicized 
Characters 
Sometitnes Word puts too much space 
between italicized words (especially if 
each word is capitalized, as in subheads 
or titles). Simply condensing italicized 
type usually results in squished type. But 
if you tum on Show from the Edit menu, 
you can select the space markers be­
tween the words and condense only them 
by using the Condense feature found in 
the Character dialog box. You can con­
dense by anything from 0 to 1. 75 points. 
After you've highlighted the first space 
mark and condensed it, go on to the next 
space mark, highlight it, and press Com­
mand-A ("Again") so you don't have to 
reenter the values in the dialog box. 

Dialog Box Command Keys 
Word allows users to substitute command 
key combinations for mousing in all dia­
log boxes. Any dialog box can be can­
celed by using Command-period. 

In The Save As ... dialog box: 
Command-S saves the file; 
Command-C cancels; 
Command-D switches drives; 

In the Open ... dialog box: 
Command-O opens the highlighted 
file; 
Command-C cancels; 
Command-D switches drives; 

In the OK or Cancel dialog box: 
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Command-O presses the OK button; 
Command-C cancels the box. 

In the Change ... dialog box: 
Command-F finds the next; 
Command-C selects Change 
Selection or Change All. 

Creating Double And Triple 
Lines In Word 
Set Below and Double borders on the 
Paragraph selection under the Format 
menu to create a double line underneath 
a paragraph. For a really interesting ef­
fect, go to the paragraph directly below 
the double-underlined one and set the 
borders for Double and Above. The re­
sults will be three horizontal lines. 

Changing Your 
Personalization Of The 
Master Disk 
Word lets you "personalize" your master 
disk by entering your name and/or or­
ganization into a dialog box. Unfortu­
nately, once you do it, all future backup 
copies will display this information in an 
Info box as soon as you open the appli­
cation. Even though Word's documenta­
tion states that your disk will be "perma­
nently marked," you can change the 
personalized information display pretty 
easily using a file editor like FEdit or 
ResEdit. First, display Word's data fork 
with FEdit. Pull down the Options menu 
and select SET EOF or SET END OF FILE. 
Then select ZERO, which eliminates 
Word's data fork. 

The next titne you run Word, it will 
pron1pt you to enter the "personal" infor­
mation again, as if you had a brand-new 
master copy. (This also works with the 
personalization screen of Excel.) 
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Finding The Next 
Occurrence Of A Format 
To find the next occurrence of a font or 
character format, put the insertion point 
within an example of whatever format 
you're searching for and type Command­
Option-Q. Word will then search for the 
next appearance of text with the same 
formatting as that around the insertion 
point and select it. 

To make using style sheets faster, you can 
add unique letters or numbers to your 
style-sheet names that let you call them 
up by these characters rather than the 
sheet's full name. 

Open the Define Styles dialog box, select 
a style sheet, type a comma after the 
sheet's name, then enter the character 
you want to use. The next time you want 
to apply this style, just type the abbrevia­
tion. 

Placing A Box Around Text 
Here are two ways to place a box around 
text while in Word. 

If the text isn't justified, select all but the 
last paragraph to be boxed and then use 
the Change command to replace all the 
paragraph markers (Ap) with line returns 
(An). This tricks Word into thinking it's 
looking at one large paragraph, so you 
can now apply whatever formatting you 
like from the Paragraph Dialog box. You 
can do the same thing with justified text, 
but to prevent partial lines from spreading 
across the page, replace the normal spaces 
with non-breaking fixed spaces (Option­
spacebar or Command-spacebar). 

For paragraphs that have different mar­
gins or indents, you can use Side by Side 
formatting to create your boxes. Insert a 
graphics box in its own paragraph above 
the paragraphs to be boxed, making sure 
that its left margin lies to the left of the text 
you want to enclose. Size the box to the 
appropriate width and length, and then 
add whatever outline formats you wish. 
Select the box and the paragraphs and 
apply the Side by Side Paragraph format. 
You can check the results in Page Preview 
and resize the box as necessary. 

Placing A Background 
Screen Behind A Paragraph 
There are times when you may want to 
accent Word paragraphs with a back­
ground screen. The following PostScript 
command, placed before a paragraph, 
will do the job: 

para. 0 0 moveto 0 1000 rlineto 
1 000 0 rlineto 0 -1 000 rlineto 
closepath gsave . 97 setgray fill 
grestore 

This instruction must be in PostScript 
style, which is one of Word's automatic 
styles and can be applied by entering 
PostScript in the Define Styles dialog box. 
The value 1000 will handle any paragraph 
up to 13 inches square, but if you want a 
smaller area, which will also print faster, 
you can pick a more realistic value by 
multiplying the number of inches by 72 
and using that result. You can adjust the 
intensity of the gray scale by changing the 
.97 next to setgray. The closer this value 
is to 1, the lighter the screen. Word con­
siders the space above and below your 
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paragraph to be part of it, so some white 
space may get filled unless you use the 
Paragraph command and set this space to 
ze ro . 

Printing Legal-Sized 
Documents On The 
Laserwriter 
You might find that tly ing to print legal­
sized Word docume nts on a LaserWriter 
results in the top two inches of text being 
cut off. The solution to the p roblem is to 
select a larger printing area . 

Just hold clown the Shift key when you 
choose Page Setup. After selecting Legal 
Size, click the Option button. Choose Lar­
ger Print Area from the Option menu. 
Your documents should print without 
any problems. 

WORD 3.0 

PostScript Code To Place 
A Border Around A Page 
He re's a PostScript seque nce that places a 
borde r around an entire page: 
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. pa9e . 
/wp$new [ newpath 36 36 
moveto wp$x 72 su b 0 rl ineto 0 
wp$y 72 sub rlineto wp$x 72 sub 
neg 0 rlineto closepath ] def 4.0 
setlinewidth wp$new stroke 

This sequence places a box with a 4-
point-wide border indented 36 points 
fro m eve1y edge. The number 72 is simply 
2 x 36. Change 36 to 72 and 72 to 144 to 
achieve a l-inch border and modify the 
number before the word setlinewidth to 
suit your needs . 

Marking A Document Draft 
If you wa nt to mark a draft Word docu­
ment to print out on a LaserWriter as such , 
insert, in PostScript style, the text below in 
a header before the normal header infor­
mation. You can also insert this code just 
before the first paragraph on each page of 
a document, but putting this into the 
heade r saves you a lot of pasting and 
formatting. And in case you need remind­
ing: to format this text in the PostScript 
style, select it, go to the Define Styles 
menu , and type PostScript . 

. page. 
/ TM {wp$y wp$top sub} def 
/ LM [wp$1eft] def 
/ RM {wp$x wp$right sub} def 
/ printline TM 100 sub def 
/ putcenter 
{dup 
RM LM sub 
exch stringwidth pop sub 
2 div lM add 
3 -1 roll move to} def 
/ AddToPath 

{ putcenter 
true charpath 
} def newpath 
/Ti mes-Bold findfont 140 scalefont 

setfont 
printline (D) 

AddToPath 
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printline 140 sub (R) 
AddToPath 
printline 280 sub (A) 
AddToPath 
printline 420 sub (F) 
AddToPath 
printline 560 sub (T) 
AddToPath 
gsave 
0.9 setgray fill 
grestore 

When you print your docume nt, this code 
will place the lette rs "DRAFT" centered 
down the page in a light gray. 

WoRD 3.01 

Numeric Keypad 
Equivalents For Mac SE 
And II Users 
Here are !>ome shoncuts for Mac SE and 
II users who work with numeric keypads: 

I re peats the last thing you d id. 

• scro lls down one line when pressed 
and released, or scro lls continuously 
when held clown. 

+ scro lls up one line when pressed 
and released, or scrolls up continu-

ously when held down. 
- extends the selection to the next oc­
curre nce of any item you ente r, such 
as characters, paragraphs, number 
signs, bullets, e tc. 

= finds the next Search Ite m, even if 
you've cancelled the Find dialog box. 

0 returns the cursor to its last three 
locatio ns, o ne location for each press 
of the button. 

5 returns to the regular screen from 
Page Preview. 

Shortcuts When 
You "Save As .•. " 
There are a number of keyboard shortcuts 
you can take if you 'cl rather work through 
the keyboard than the mouse: 

Command-S saves the file. 

Command-£ ejects the disk. 

Commanci-C cancels the dialog box. 

In the Delete dialog box, the same com­
mands work, except that Command-S 
activates the De lete command. 

Using MacDraw To Convert 
Typed-In Capitals To 
Lowercase Letters 
Word can't convert text that was typed in 
capitals into lowercase letters . Pressing 
Command-Shift-K toggles berween text 
"as typed"' and all uppe rcase, but it doesn't 
convert text initially typed as capitals into 
lowercase letters. Also, the capita lizing 
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e ffect can't be used in a document saved 
as "Text O nly. " The re 's a work-around to 
this problem if you have a copy of 
MacDraw: 

Text copied from Word can be pasted into 
MacDraw. Then, select the pasted text 
while in MacDraw, and choose Lower­
Case from the Style menu. Then, copy the 
text and paste it back into your Word 
document. The text will now be perma­
ne ntly saved as uppercase le tters .. . even if 
you save the document as Text Only. 

Using Uppercase 
Commands When You're 
Using Capitals In A 
Document 
If a large amount of your docume nt is 
going to be typed in capital letters, use the 
All Caps character format (Command­
Shift-K) instead of the Caps Lock key. 
This lets you check your text fo r spelling 
erro rs without deselecting the default 
Ignore Words in All Caps setting, and also 
lets you change the text back to normal 
lowercase fom1at (including proper nouns, 
as lo ng as you remember to Shift when 
you type) by removing the All Caps 
selection . 

Creating Structured 
Footnotes 
The footnote command may be very 
useful, but if you try to create scientific 
structures such as " ... can be fo und in 
several review anicles 1-12" it can be a 
trying experience. You can work around 
this limitation by using Word's hidden 
text feature. 
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While typing a manuscript, use the foot­
note command to enter all of the foot­
notes. Separate the first and second foot­
note numbers with a hyphen or an em 
dash, and then separate the rest of the 
footnotes w ith commas. This creates a list 
of reference marks that display as " ... can 
be found in several review articles 1-2, 3, 
4, 5, 6, 7, 8, 9,10, 11, 12." 

1 ext, select the second through the next­
to-the-last numbe rs, including the last 
comma (in this example, 2-11). Format 
the selection as Hidden text, using the 
Character command in the Format me nu 
o r by typing Comma nd-Shift-X. The 
modified sente nce displays and prints as 
'· ... can be found in several review articles 
1-12" when the Show Hidden option in 
d1e Edit Preferences dialog box is not 
selected. 

Creating A Solid Underline 
When using Word to create a form, you 
can't rely on using a series of typed 
underline characters to create a solid line. 
Some fonts show the line on-screen as 
being solid, but when you print them out 
the results will be far less even. To make 
a solid line that stays solid when you print 
it out, set Underline as your style and then 
type in blank characters with the space 
bar. If you press the Command key while 
typing, you'll create "hard'' spaces, which 
the program will keep on the same line. 

How To Keep 
Outline Entries Intact 
When an outline is renumbered , so are 
entries that start with numbers. A work­
around is to choose Styles from the For-
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mat menu to set the font for your various 
outline levels to some font that doesn't 
use the square sytnbol (the one you get 
when you press Option-H). Palencia is 
one such font. 

Every time you type a number which 
starts an entry in the outline tnode, pre­
cede the number with the Option-H 
square. When you renumber and leave 
the outlining window, the square charac­
ters will disappear. 

This allows your outline to print, and you 
won't lose any of the data or text you 
entered. 

Copying Parts 
Of A Style Sheet 
It's possible to copy one or just a few 
styles from one Word document's style 
sheet to another, without bringing in the 
entire style sheet. First, open the docu­
ment that contains the style(s) you want 
to copy. Select a paragraph that's forn1at­
ted in that style (to copy several different 
styles, copy a series of paragraphs). 

Now, open the docutnent to which you're 
going to copy the styles, and paste the 
paragraphs into the style sheet. The new 
styles are now a part of the old style sheet. 
So now, you can delete the text you 
pasted in, and the styles will remain in the 
document. 

Spell-Checking Around 
Ligatures 
If you use a lot of fi and flligatures in long 
documents, you'll save time n1nning the 
spelling checker by replacing the charac-

ter pairs "fi" and "fl" with the ligatures 
AFTER the spell-checking is completed. 
The spelling checker can't recognize liga­
tures as alphabetic characters, and you 
can't add words that contain then1 to your 
dictionary. So, if you put the ligatures in 
before running the spelling checker, the 
program regards any retnainder of a liga­
ture word to be tnisspelled - unless the 
remainder happens to n1atch a word in 
the Main dictionary. 

After the spelling checker has finished 
running, go to the start of the document 
(Cotnmand-Keypad 9), open the Change 
dialog box (Command-H), set the re­
placetnent parameters, select Match 
Upper/Lowercase, and click Change All. 

Avoiding Disk-Swapping 
Hassles 
A lot of people use several different docu­
ment disks during a single work session. 
If you do, and you work on a floppy disk­
based systen1, you can avoid a lot of disk­
swapping by double-clicking on the Word 
application, instead of a document, when 
you start working. 

Correcting Pagination 
Problems With Serial 
Printer Drivers 
When you use the serial printer driver 
with either a 12- or 15-pitch printer, you 
tnust first set the line spacing for all 
paragraphs, or the pagination will be 
incorrect. When you create a new docu­
tnent, first go to the Paragraph dialog box 
under the Format rnenu and set the line 
spacing to 12 points instead of the default 
spacing, "auto." 
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If you are having problen1s printing an Just ren1ember to redefine your Graphics 
existing document, select the entire text style by cancelling the Hidden character­
and then go to the Paragraph dialog box istic before you print or repaginate. 
and do the procedure described above. 

Twelve is the proper setting to e1nulate a 
single-spaced typewriter which produces 
6 lines per inch. To en1ulate other spac­
ing, set a value of 72 divided by the 
nun1ber of lines per inch. 

Pasting Some Graphics 
Can Cause Problems 
When pasting a graphic from an object­
oriented program (such as MacDraw ), 
you might experience some problems if 
the graphic's rightmost elen1ent is a verti­
cal line. To get the line to appear, place 
a non-printing character, like a space, just 
to the right of the line. The character 
won't show up when you print the docu­
ment, but Word will no longer think that 
the line is the righttnost object on the 
screen, so it will allow the entire drawing 
to be pasted in. 

Speeding Up The Graphic 
Redrawing Routine 
Word can take what see1ns like forever to 
redraw a cotnplex graphic, especially one 
that has had smoothing activated for its 
curves. You can avoid this by creating a 
special Graphics style for each graphic, 
and including Hidden as one of its char­
acteristics. Make sure that your Prefer­
ences setting has Show Hidden Text set to 
Off. Now, you'll be ahle to quickly scroll 
through and edit text in the document, 
without having to wait forever for graph­
ics to redraw. 
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Code-Replace Capability 
Comes In Handy When You 
Import Text 
A little-known Word feature is an ASCII 
code search-and-replace capability that 
c01nes in handy when you use Word to 
edit and refonnat text files created on an 
MS-DOS-based c01nputer. To find a par­
ticular ASCII code within a Word docu­
ment, type a caret (Shift -6) followed by 
the decin1al value of the ASCII code in the 
Find What dialog box. 

Here's an exan1ple, based on a typical PC 
text file itnported into a Mac environment: 
First, select Change from the Search Menu 
or type Con1mand-H. 

Then, replace the double carriage-return 
I line-feed (CR/LF) pairs at the end of 
each PC text paragraph with a special Mac 
character as follows: 

Click the I-bean1 to the left of the first 
character in the file. In the Find What box 

' type /\13/\10/\13/\10 (13 is the decimal 
value of the ASCII carriage-return code; 
10 is the decimal value of an ASCII line 
feed). 

Now, in the Change To box, type Option­
S to get a bullet or another special Mac 
character not used in the file. Click Start 
Search or Change All to make the changes. 
Then, replace the CR!LF codes at the end 
of each line within paragraphs with a 
space: With your insertion point at the top 
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of the document, enter "13/\10 in the Find 
What box; in the Change To box, type one 
space; and then click Start Search or 
Change All. 

Finally, go back and replace the special 
Mac character (like the bullet) you used to 
mark the end of PC text file paragraphs, 
with a Return. First, click the I -beam at the 
top of the file. In the Find What box, type 
a bullet (or whichever special character 
you used). In the Change To box, type "P 
(a caret followed by a lowercase p repre­
sents a Word Return character). Click Start 
Search or Change All as you did before. 

You can also use this ASCII code search 
feature to fix PC word-processing docu­
ments within Word. For example, some 
PC documents contain normal text with 
only occasional ASCII control codes (such 
as decimal value 12 for form feeds or 9 for 
tabs). Use FEdit Plus or another file edit­
ing utility to examine the codes in the PC 
document, and then use the technique 
described above to search for and delete 
these codes within Word. For a complete 
list of the decimal values of all ASCII 
codes, see the Appendix of the Word 
manual. 

As it happens, you can also reverse this 
process. You can replace Return charac­
ters in a Word text file with ASCII CR/LF 
codes. This allows you to create files that 
PC friends and co-workers can use. 

Of course, only perform the search func­
tions on a backup copy of your file, just 
to be on the safe side. 

Printing Long Documents 
With Page Numbers 
The Word tnanual describes a rather in­
volved procedure for people who need to 
print long documents (n1eaning docu­
ments con1posed of several Word files) 
that have page ntnnbers. One particularly 
annoying hoop you have to jump through 
is having to repaginate each part of your 
document, finding out what its last page 
nun1ber is, and then having to set up the 
next file so that it starts with the next page 
number. 

There is a work-around to this situation. 
Choose Page Setup for each file, and type 
the file nan1e of the next file, as the 
tnanual says. Then, WITH THE EXCEP­
TION OF THE FIRST FILE of the set of files 
composing the docun1ent, blank out the 
Start Page Numbers At box. That is, leave 
a 1 in the Start Page N un1bers At box for 
the first file, and erase the 1 in that box for 
all the other files. Now, reopen the first 
file of the document and tell the Mac to 
print. 

The entire document will print out with 
the right pagination, without your having 
had to repaginate each file. 

This only works if you begin printing with 
the first file of the series. If you print a file 
that appears in the n1iddle or end of the 
set of docun1ent files, you'll have to 
follow the instructions in the Word man­
ual. 
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Cleaning Up Returns In 
Print Merge Documents 
When creating a list of nan1es or ad­
dresses, for example, for print-merging in 
Word, making sure you have appropri­
ately "Commanded" and "Shift-Returned" 
each and every set of data can be unnerv­
ing. (Remember a Return is only entered 
at the end of each record, while a Shift­
Return may be used for arranging the data 
more logically.) To eliminate most of the 
problem, you can use the Document Re­
number command to nun1ber each set of 
data which isolates the entries with just a 
Return instead of the desired Shift-Return. 
Where you find the erroneous Retutn, put 
the cursor in front of the entry and press 
the Delete key, then press Shift-Return. 
Using the Document Renumber com­
mand also lets you know just exactly how 
many names or addresses you have. 

Changing The Length Of 
Word's Menu Titles 
You can't change Word's menu titles to 
something less verbose with a utility such 
as ResEdit, because Microsoft doesn't use 
tnenu resources. So, use a file editor such 
as FEcHt and perform an ASCII Search for 
the capitalized word "Document." This 
reveals the program area where the names 
of menu titles are stored. Each title is 
preceded by the length of the title. For 
exan1ple, change the 8 in front of "Docu­
nlent" to 3, then issue the con1n1and 
WRITE SECTOR. That's it. Using this tech­
nique, you can cotnpletely rename or 
shorten Word's menu titles. If you rename 
titles, n1ake sure your new titles are no 
longer than Word's old ones. 
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Finding The Missing Comma 
in Data Record 
The easiest way to find a missing comma 
in a data record, while doing a Print 
Merge, is to select the New Doclllnent 
button in the Print Merge window. This 
creates a document on the screen. When 
you come across the "Missing Comtna in 
Data Record" dialog box, quit the Merge 
and scroll the document to the last record. 
The next record in your data file is the one 
with the probletn. Once you have a 
successful Merge to the screen document, 
select Print and you are assured of print­
ing the entire batch successfully. 

One Way To Count Words 
Here's one way to count words in Word 
3.0 and 3.01. 

Make a copy of your document and use 
that, as this procedure will change the 
document. Select Change fron1 the Search 
menu. Enter w (the white spaces) in the 
Find What box and n (end-of-line marks) 
in the Change To box, then choose Change 
All. When this operation is complete, 
you'll find the number of changes (which 
is very nearly the nun1ber of words) in the 
lower left corner. 

If, by mistake, you do this on your original 
docun1ent, all the words will be arranged 
in a column. Save the situation by closing 
the docun1ent and clicking No when the 
dialog box asks if you want to save the 
changes. 
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How To See The Size Of A 
File Without Returning To 
The Finder 
Here's a good way to see how big (in K) 
your Word 3.0X files are. This method 
works without having to return to the 
Finder. 

Start by saving the document. Then close 
its window and choose Delete from the 
File menu (if you don't see Delete, that 
means you're in Short menus and must 
change to Full or Normal menus). Select 
the document you wish to see the size of 
from the list. The size will be shown 
under the buttons. This size is rounded 
down to the nearest kilobyte. (That's dif­
ferent from the Finder, which displays the 
size to the nearest K rounded up; and Get 
Info, which shows the exact size in bytes. 
Here's an example: The file is actually 
9728 bytes long. Get Info will show that 
number or 9.SK; the View option of the 
Finde r will show lOK; and the Delete 
dialog will show 9K.) Remember to hit the 
Cancel button afte r you check the size. 

When You Get The "Missing 
Comma In Data Record" 
Error Message 
Word's Print Merge capability requires 
that you separate field names with com­
mas or tabs. Unfortunately, when you ac­
cidentally omit o ne, the program simply 
puts up an error message, without telling 
you whe re your comma might be missing. 
Instead of going through each and evety 
record you're working with, you can use 
this shortcut: 

Count the number of commas in the 
header record , and then use the Change 
command to systematically isolate the 
record that's missing a comma. You do 
this by e ntering a comma into both the 
Find What box and the Change To box. 
Then select sections of records and statt 
searching. 

~ord counts the number of changes that 
tt makes, and puts that number into the 
lower left corner. If the number of 
changes is not evenly divisible by the 
number of commas in the header record 
you know that the defective record i~ 
somewhere in the records you just se­
lected. If the number is evenly divisible, 
you can move on and select another 
section. Continue this process until you 
nar:row down the data records sufficiently 
to rsolate the one or more records with 
missing commas. 

WoRD 3.01 

Accessing Help Fast 
You don't have to d ig out your manual 
evety time you need he lp, if you have 
Apple's Extended Keyboard. The key, 
labeled "Help,·· is right under d1e F13 key. 
When you p ress it, you'll see a question 
mark appear. This is your cursor. Move 
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it to w hatever you want explained , in­
clud ing menu choices, and then just click 
the mouse for the help you need. 

I f you don 't have the Extended Keyboard, 
press the Command key and and the? key 
to get the question cursor. 

Word Features Not 
Appearing In The Menus 
Word 3.01 has several features that are 
only accessible through the use of special 
key combinations. These features nor­
mally never appear in menus. Yet, work­
ing with the program vvoulcl often be 
simpler if they did. 

Let's take the example of Insert Page­
Break. The only way (normally) to access 
this feature is to type Shift-Enter. Here's 
how to make th is feature a menu cho ice. 
Start w ith a blank document. Be sure you 
arc in Full Menus mode. Type Shift-Enter 
to produce a forced page break. Select the 
cloned line that results by clicking in the 
Selection Bar (the column at the left o f the 
screen w here the cursor points northeast 
instead of northwest). Then choose Glos­
s~uy from the Edit menu. Type in a de­
scriptive name, such as "PageBreak ," and 
click on the Define button. ext, press 
Option-Command-+ (plus sign) and click 
on the name Pagebreak in the glossa1y 
list. A Work menu w ill be created (or 
added to . if you already have one), in 
which the new glossaty entty will be 
found. Now w henever you want to insert 
a page break, just go to the Work menu 
and select one. 

This method will work w ith the orher key 
combinations \XIo rd forces you to memo-
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rize. These include: Section Mark, Com­
mand Enter, End-of-Line Mark, Shift-Re­
turn , Optional Hyphen, Command­
(hyphen), Non-breaking Hyphen, Com­
ma ncl--(tilcle). 

WORD 3.02 

Repaginating Without 
Crashing Using Word 3.02 
And The Laserwriter II SC 
Opening a document in Word 3.02 and 
then doing any procedure which repagi­
nates the text causes a Bomb message 
and a crash. 

To correct this, select the Laser Writer II SC 
driver using the Chooser evety time you 
open Word. Do this even if the Laser­
Writer II SC driver is the only one in the 
System folder, and it's already been cho­
sen while you were in the Finder or 
another application. Once you·vc chosen 
the Laser\Xfriter II SC \Vhile in Word 3.02, 
you·ll be able to switch applications and 
print with no further problems. 

Swapping Adjacent 
Paragraphs 
Want to swap the positions of two adja­
cent paragraphs quickly, without using 
multiple executions of Cut, Copy, and 
Paste? 
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Highlight the paragraphs and check the 
alphanumeric position of the tlrst word in 
each paragraph. Then use the Sort con1-
n1and (Word will sort in ascending order) 
or Shift-Sort (descending order) accord­
ing to the alphanumerics. With a little 
forethought, you can figure out how to 
move two paragraphs around a third 
paragraph that separates them. You can 
also install n1arkers at the heads of as 
rnany paragraphs as you wish to rear­
range. 

Use Sort and ren1ove the markers when 
you're finished. The variations of Sort are 
endless once you get the hang of this 
useful and underused tool. . 

Bonus Disk 
Word 3.02 and above c01ne with a Bonus 
Disk, with aDA called Word-Finder. The 
thesaunts only works with Word or the 
Finder- it only functions if the informa­
tion in the About... box of the active 
application says "About Microsoft Word ... ", 
"About MS Word ... ", "About Word ... ", 
"About Finder ... ", or "About DAs ... ". 

Using ResEdit, you can custotnize Word­
Finder to work with any application that 
has a MENU resource. First, open ResEdit 
and then open the desired application. 
Open the application's MENU resource 
and open MENU ID= 1. Change the first 
menu iten1 to "About Word ... " (with three 
periods!) and save your changes (see 
Figure 3). WordFinder can now provide 
you its riches in the modified program. 

Using The ASCII Code 
Search-And-Replace 
Capability 
Microsoft Word 3.02 and above have an 
ASCII code search-and-replace capability 
that can come in handy when using Word 
to edit and reforn1at text files created on 
an IBM PC or PC clone. To find a particu­
lar ASCII code within a Word document 
type a caret (Shift-6) followed by th~ 
decimal value of the ASCII code in the 
Find What dialog box. Here's how to use 
this feature to fix a typical PC text file 
in1ported into the Mac environment 
(always work on a backup copy of the file 
you wish to convert): 

1. Select Change from the Search Menu 
( Cotnmand-H). 

2. Replace the double carriage-Return 
I line-feed ( CR/LF) pairs at the end 
of each PC text paragraph with a 
special Mac character as follows. 
Click the I -bean1 to the left of the first 
character in the file. In the Find 
What box, type A13A10A13A1QA (13 
is the decin1al value of the ASCII car 
riage-return code; 10 is the deciinal 
value of an ASCII line feed). 

3. In the Change To box, type Option­
S for a bullet ( •) or another special 
Mac character not used in the file. 
Click Start Search or Change All to 
n1ake the changes. 

4. Now, replace the CR/LF codes at the 
end of each line within paragraphs 
with a space: With your insertion 
point at the top of the document 
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enter " 13"10 in the Find What box; 
in the Change To box, type one 
space; and then click Start Search or 
Change All. 

5. Finally, go back and replace the 
special Mac characters (used to mark 
the end of PC text file paragraphs) 
with a Return. First click the I-beam 
at the top of the fil e. In the Find 
What box, type a bullet (or whatever 
special character you used). In the 
Change To box, type " P (a caret fol­
lowed by a lowe rcase p represents a 
Word Return character) . Click Starr 
Search or Change All as before. 

You can also use this ASCII code search 
feature to fix PC word-processing docu­
ments within Word . For example, some 
PC documents contain normal text with 
only occasional ASCII control codes (such 
as decimal value 12 for form feeds or 9 for 
tabs). Use FEclit Plus or anothe r Mac file 
editing utility program to examine the 
codes in the PC document, and then use 
this technique to search for and delete 
these codes w ithin Word. For a complete 
list of the decimal values for all ASCII 
codes, see the Appe ndix in the Microsoft 
Word manual. 

By the way, the reverse of this process 
works as well. You can replace return 
characters in a Word text file with ASCII 
CR/LF codes. This allows you to create 
readable text files for your PC frie nds and 
customers without leaving your Mac. 
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Making Word Finder Work 
With Any Application 
Word 3.02 and above come with a Bonus 
Disk, with a DA called Word Finder. The 
thesaurus only works with Word or the 
Finder- it only functions if the informa­
tion in the About.. . box of the active 
application says "About Microsoft Word ... ", 
"About MS Word ... '·, "About Word ... " 
"About Finder ... ", or "About DAs .. . '· . 

Using ResEdit, you can customize Word 
Finder to work with any application that 
has a MENU resource. First, open ResEdit 
and then open the desired appliq tion. 
Open the applications ME U resource 
and open MENU ID=l. Change the first 
menu item to "About Word ... " (with three 
periods!) and save your changes. Word 
Finder can now provide you its riches in 
the modified program. 

WoRD 4.0 

The Word Screen Saver 
Ordina1y screen savers may dim your 
screen or offer fireworks and clock dis­
plays, but in Word 4.0, there's an ani­
mated display that is quite beautiful in 
color. Select Commands from the Edit 
menu and choose Screen Test from the 
list of commands in the dialog box. Click 
on the Do button. If you click once while 
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the images are dancing across the screen, 
a dialog box will let you customize the 
display or cancel it. 

Smoothing The Transition 
From Word 3.0 To Word 4.0 
1. Word 3 and Word 4 can coexist on the 
same hard disk, each with its individual 
preferences file in the Systen1 folder, but 
we recommend against keeping the old 
version on-line. Docutnents have the same 
creator and type IDs in Word 4 and Word 
3, so keeping track of document versions 
can get very confusing. If your Word 4 is 
sensitive to errors in its preferences files, 
however, and it might be a good idea to 
erase the "Word Settings (4)" file in the 
System folder and redefine your prefer­
ences if the application is bombing. 

2. It's easy to move your personal style 
definitions from Word 3 to Word 4. Sim­
ply go into Word 4 and select Define 
Styles. Then use the Open menu item to 
open a Word 3 file, which tnakes all its 
styles available. Any styles you want to 
keep in Word 4 can he saved with the Set 
Default button. 

3. Word 4 retains the ability to deal with 
any ASCII characters, invisible or other­
wise, by specifying their numeric equiva­
lents. In the older version, you could find 
the value for a selected character by 
clicking on the page number at the lower 
left corner of the screen. In the new 
version, Command-Option-Q is the only 
way to show the numeric equivalent. 

4. Word docun1ents that are "fast-saved" 
cause problems for Working Software's 
Spellswell spelling checker and may be 

troublesome for other applications that 
try to convert then1. There is a clever 
work-around, however, that allows you 
to change Word's default format fron1 Fast 
Save to norn1al. Use Word 4's Con1mands 
menu to add Fast Save Enabled to a menu 
such as the Edit menu. Once it is on a 
menu, you can select it to uncheck it, and 
it will retnain off until you specifically turn 
it on again. 

5. Finally, for a little fun, select About 
Microsoft Word... , then click on the 
Word icon while holding down the Com­
mand key. 

Creating Tables With 
Varying Column Widths 
The Insert Table con1mand in Word 4.0 
only lets you create a table with columns 
of equal width. Ordinarily, you have to 
struggle with the colurnn markers across 
the ruler to vary the column widths, but 
there is a shorcut that n1akes it easy: 

1. Say you're creating a three-column 
table with one narrow column on 
the left for labels and two wide col­
umns to the right for entries. As you 
create the table, enter 5 in the Number 
of Columns box. 

2. Select all the cells in the second and 
third columns by holding down the 
Option key while dragging the mouse 
over these colun1ns. 

3. Choose Table fron1 the Edit menu 
and select the option for n1erging the 
tow columns. Repeat this procedure 
with colmnns 4 and 5. 
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You now have a three-colun1n table. To 
get a narrower first column and wider 
entry columns, just increase the number 
of columns in the table by a factor of 2. 

Creating An 
On-line Hints Menu 
Word users have been inundated with 
docutnentation, help files, and third-party 
books discussing all the progratn's intri­
cate features. Trying to keep track of all 
this information in its present state is 
tnind-boggling but worth the effort. 

To have this infonnation literally at your 
fingertips, create a file natned Hints in 
which you store a personalized set of 
con1tnands, shortcuts, and tricks that you 
want to keep at your fingertips. Give this 
Hints file menu-bar status by adding it to 
the Work tnenu. Press Conlmand-Option­
+ (plus syn1bol). When the cursor turns 
into the plus symbol, click on your Hints 
document, either in the Open dialog box 
or in its title bar (if it is the active docu­
ment). 

Word will create a Work tnenu on the 
right-hand side of your menu bar or add 
your Hints docUinent to an existing Work 
tnenu. 

Launching MacWrite 
Documents With Word 
Whenever you double-dick on a plain­
text MacWrite document (such as the 
docUinentation files you download fre­
quently from bulletin boards), it won't 
open unless you have MacWrite on your 
disk. As a lot n1ore people use Word 4.0 
than Mac\Xfrite, here's a way to make 
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Word 4.0 auton1atically open those 
MacWrite documents in its own format 
when you double-click on then1. 

First, make a backup copy ofMacWrite (if 
you have it installed) on a floppy and then 
delete it from you hard drive. 

Next, tnake a duplicate copy of Word 4.0 
on the hard drive and rename it Mac Word. 
By using ResEdit, you can change the 
Creator of Mac Word from MSWD to MACA 
(highlight MacWord and choose Get Info 
from the File menu). Make the changes in 
the Creator box. 

Now, when you double-click on a 
MacWrite document, MacWord will launch 
and the document will be converted 
automatically. 

Quickly Adding Fonts To 
Word's Font Menu 
If you need to add font names to Word 

4.0's Font menu, pressing Command­
Option-+ each time can get tedious in a 
hurry. Here's a fast, undocumented way 
to add all the currently installed fonts to 
your menu. 

Choose Commands from Word's Edit 
menu, and choose List All Fonts from the 
list of cotnmands. Then click on the Do 
button. 

The n1enu bar will flash as Word adds 
suitcase fonts one at a time to the Font 
menu. 
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A Patch For Fractional Font 
Widths On lmageWriters 
If you do not own Adobe Type Manager, 
and you are using Microsoft Word, there 
is a patch- a set of n1odifications to Word 
- that allows for fractional font widths on 
Image Writers. It's called WORD4MOD.SIT. 
Ot should be available fron1 the usual 
shareware outlets such as user-group 
libraries, BBSs, and so on. On Con1puS­
erve its's called WORDMO.BIN in the 
Macintosh Productivity Fonm1's word­
processing library.) 

Installing the patch requires fan1iliarity 
with ResEdit (available fron1 the same 
outlets). Obligatory ResEdit warning: 
Never use ResEdit on an original or n1aster 
of anything. Always work on a copy. And 
don't forget to lock your n1aster disks. 
That way, if you happen to make a 
mistake and dan1age son1ething, you can 
always make a fresh copy from the n1aster 
disk. 

Recovering Word 
Temp Files 
Before you save a Word docUinent, Word 
sets up a temporary file and places it in the 
System Folder. If your system has crashed 
and you want to try recovering a Word 
Temp file, you can try opening it by 
holding down the Shift key and choosing 
Open Any File from Word's File menu. 
That should enable you to open the Ten1p 
file (try the one with the highest nunlber). 
If you want to, you can add the Open Any 
File command to your rnenu pennanently 
by using Word's corntnand option, which 
you'll find on the Edit n1enu. 

Kerning With The 
Displace Command 
Microsoft doesn't mention kerning any­
where in the Word manuals, but you can 
do ntdirnentary kerning with the Displace 
Command. To kern two characters: 

1. Choose Show 9f fron1 the Edit menu. 

2. Place the cursor between the two 
characters you want to kern. 

3. Press Option-Cotntnand-backslash 
and then type the letter D (the 
forn1ula code for Displace). 

4. Press Option-Comrnand-backslash 
again, and then type the letters BA 
(the fonnula code for Backward). 

5. Enter the nun1ber of points to kern 
(in whole points). 

6. Follow this with both open and dose 
parentheses ( ) to end the forn1ula. 
The code you see on-screen should 
look like this: \d\ ba3 ( ) (using3 
points as an example). 

7. Choose Show again or print your 
text, to see the difference in spacing. 
If you save this formula as a Glossary 
itern, you'll have to enter it only 
once. 

Inserting The Date 
Into Documents 
Word lets you insert the date into docu­
n1ents through its Commands dialog box, 
but you're stuck with its date formats, 
which include the day of the week (ex-
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cept for the short format- for example, 3/ 
31/89). If you want a date such as March 
31, 1989, you'll have to suppress the 
weekday in the Systen1 file with ResEdit 
1.2. (Try this on a copy of your System file 
before you change your working System 
file.) 

1. Open the Systetn file and scroll 
down to itll. 

2. Open it11. Select it11 US" ID=O and 
open it. 

3. Next, click on the Suppress Day box 
(see Figure 2). 

4. Close ResEdit and save the changes. 
Open a Word document. To get the 
date, make sure you're using Full 
Menus and select Glossary fron1 the 
Edit menu. You'll see the following 
date entries: date - now - abbrevi 
ated, elate - now - long, and date -
now- short. 

Select either the long or the abbreviated 
format and click on Insert. The date will 
appear either as March 31, 1989, or as 
Mar. 31, 1989, respectively. 

Using Insert Graphic To 
Speed Printing Thne 
Inserting a graphic in a word-processing 
document can significantly increase print­
ing tilne. Here's a trick for trimming your 
printing tin1e on working drafts and proofs. 
Measure the illustration's height (many 
object-oriented draw programs have a 
Show Size option). Insert the graphic into 
a Word document. With the graphic se­
lected, choose Paragraph from the For-
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mat menu. Type a n1inus sign in the Line 
Spacing box and then enter the graphic's 
measurement. The minus sign adjusts the 
paragraph's height to match the size of 
the graphic. 

Select the graphic again, choose Charac­
ter from the Fonnat menu, and format the 
graphic as hidden text. When you print 
draft doctnnents, he sure Print Hidden 
Text in the Print dialog box is not se­
lected. The illustrations will he replaced 
by an appropriate amount of white space, 
and you'll know where your page breaks 
are. When you're ready for the final ver­
sion, recheck Print Hidden Text, and the 
graphics will print properly. 

Inserting PostScript Code In 
A Word Document 
Placing bits of PostScript code (or even 
lengthy routines) into a Word document 
is simple. But Word requires that you first 
clearly define what part of the page will 
be affected by the PostScript code. Is it 
going to affect the entire page (for ex­
ample, a box enclosing the page) or just 
a paragraph or inserted graphic? 

You define the boundaries by inserting a 
group comn1and in1mediately before the 
page element it will affect. In Word 3.02, 
you could use three such con11nands: 
.page., .para., or .pic. (referring to the 
entire page, the next paragraph, or the 
next graphic insertion). Version 4.0 has 
added .cell. and .row. to facilitate Post­
Script manipulation of tabular n1aterial. 

1. Group Commands - Group cotn­
mands create a drawing rectangle that 
specifies the overall size of a PostScript 
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graphic. The actual din1ensions of the 
graphic never have to be entered, be­
cause the con1mand gathers this informa­
tion from Word it'ielf. The drawing rec­
tangle created by .page., for exatnple, is 
determined by the page size you've speci­
fied with the Page Setup comn1and. If 
your page is 5 x 7 inches, the drawing 
rectangle mirrors those tneasuretnents 
exactly. Most other group con1n1ands, 
such as .p a r a. and .p i c. let you focus 
on increasingly smaller or n1ore precise 
areas of the page - a paragraph, or a 
graphic frame within a paragraph. 

After the group cotnn1and is entered, you 
can enter PostScript code you've written 
or copied frotn another source. Here's a 
simple example that places a 5 x 7 -inch 
box on a page. At the top of the page, type 
the following: 

.page. 
newpath 
.25 setlinewidth 
126 144 moveto 
360 0 rlineto 
0 504 rlineto 
-360 0 rlineto 
close path 
stroke 

Anyone with PostScript savvy will notice 
some peculiarities here. The prin1aty one 
is that the PostScript inclusion hasn't been 
bracketed by a save /restore or gsave/ 
grestore pair, which prevents certain 
PostScript operators (rotate, for example) 
from changing the graphics environn1ent 
of the entire page. Why this apparent 
breach of PostScript etiquette? Because 

the group comn1ands automatically 
bracket each grouping of PostScript code 
with a save/restore couplet. 

You might also notice that the origin point 
(0 0) in Word's version of the PostScript 
coordinate systen1 corresponds exactly to 
that found in PostScript itself. This means 
that the origin point (0 0) is found at the 
lower left corner of the current drawing 
rectangle, whether it is a page, paragraph, 
or graphic frame. 

2. Creating Global Commands- When 
PostScript requires specific measures or 
positions that can't be referred to through 
the built -in variables, the dimensions are 
expressed in points. If you feel more 
con1fortable working in inches, simply 
place the following code after a group 
con1n1and such as .para. or .page. (and, 
of course, format it in Word's PostScript 
Style): 

/inch (72 mul} def 

Then you can use code such as I inch 1 
inch n1oveto instead of 72 72 moveto. The 
routine you've inserted automatically 
n1ultiplies the inch units by 72, converting 
them into PostScript's point systetn. 

Ordinarily, such a routine applies only to 
the drawing rectangle indicated by the 
group comn1and. So if you had a .page. 
and several .para. PostScript groups on 
the same page, you would have to insert 
/inch 172 mull def in each group. When 
Word scans the page for PostScript, it 
does each group in turn and discards the 
variables or routines of that group as soon 
as it has been processed. Even routines or 
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variables placed after the .page. coin­
mand can't be used by other groups on 
the san1e page. 

3. Executing The PostScript Code - If 
you print the document now, you won't 
n1agically have a PostScript-generated box 
on the page. The code prints as ordinary 
text. To have it executed, you must do 
several things. 

First, select the PostScript code (including 
any group con1n1and). Then hold down 
the Shift key and pull down the Forn1at 
menu. You'll see that Styles has been 
replaced by the All Styles con1n1and. All 
Styles has several predefined styles, in­
cluding one called PostScript. Select it 
and dick on OK. The PostScript code has 
now been changed into a fonn that will he 
interpreted rather than printed. To see the 
code after this point, n1ake sure that Show 
Hidden Text is selected in the Preferences 
dialog box (Edit n1enu). You can't see the 
results of your tinkering by using the Print 
Preview con1111and; you must print the 
document on a LaserWriter. 
When you print, n1ake sure that Print 
Hidden Text isn't selected in the Print 
dialog box and check the Chooser to 
make certain that Background Printing is 
turned off. If Background Printing is left 
on, the PostScript effects will he shifted 
down and to the right from where you 
want then1 on the first page of the docu­
ment. Subsequent pages will print cor­
rectly. 

4. Modifying Word's PostScript Code 
Style - The on-screen appearance of 
Word's native PostScript style leaves 
something to be desired. Fortunately, you 
can easily modify n1ost of the attributes. 
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While holding down the Shift key, select 
Define All Styles fron1 the Forn1at menu. 
Select PostScript. The description box 
defines the style as "Normal + Font: 10 
point, Bold Hidden." The n1ain culprit 
here is Bold, which makes the type hard 
to react. So just pull down the Format 
tnenu while the dialog box is showing 
and turn off Bold. You can safely change 
anything in the PostScript style other than 
the Hidden attribute. 

Using PostScript To Place 
Screen And Crop Marks 

1. Screen Marks - If you want to place, 
say, a gray screen behind a single para­
graph, you do not need to know the 
precise location and size of the paragraph. 

First, remetnber that the group con1mand 
. para. creates a drawing rectangle that 
corresponds to the size and position of 
the paragraph it precedes. And Word has 
another card up its sleeve- built-in Post­
Script variables. There are 22 variables, 
which will aid you as you develop code. 
~or a list of the variables and their descrip­
tions, see pages 285 and 286 of the User's 
Guide. 

To make a screened paragraph, we need 
the variable called wp$box. Here's what 
you need to type in front of the paragraph 
and then fom1at in Word's PostScript style 
by forn1atting the code in the Postscript 
fonnat by holding down the Shift key and 
selecting All Styles: 

.para. 
9 setgroy wp$box fill 

By the way, you don't have to use carriage 
returns, although they make the code 
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more legible. You could simply type: 
.para . 
.9 setgray wp$box fill 

In any case, the variable wp$box is equiva­
lent to defining a drawing rectangle the 
same size as the paragraph. Without it, 
you'd have to determine the coordinates 
of the paragraph (with a ruler on a 
printout) and type something like: 

1 2 6 1 4 4 moveto 
360 0 rlineto 
0 504 rlineto 
-360 0 rlineto 
close path 
fi 1 1 

These are hypothetical coordinates, but 
you can see the advantages of having the 
variables. You save a lot of typing, and 
you don't need to figure out specific 
positions or dimensions. 

2. Crop Marks - An even clearer ex­
ample is crop marks, one of six routines 
included in the PostScript Glossary that 
accompanies Word 4.0. After the actual 
crop marks are defined, the routine places 
them at the corners of the page . Ordinar­
ily, you would have to know or calculate 
exact positions for the marks, a painstak­
ingly bothersome task. But with judicious 
use of some of Word's variables, you can 
avoid the hassle: 

wp$1eft markl sub whitel sub wp$y 
wp$top sub moveto markl 0 rlineto 
stroke 

The variables wp£left, wp$y, and wp$top 
refer to the left margin , the drawing 
rectangle's height, and the top margin 

respectively. You don't need to get the 
dimensions from the Page Setup dialog 
box. Word fills in the appropriate num­
bers when the file is interpreted and sent 
to the printer. And if you change the page 
size, you don't have to go back w the 
code and insert new dimensions . 

WRITE Now 

Setting Up 
Informal Style Sheets 
You can set up informa l style sheets, 
using the dummy formats that you fre­
quently use, in a document template that 
is kept open whenever you're working in 
WriteNow. 

When you need a style , just switch win­
dows, click on the paragraph containing 
the format you need , and copy the ruler 
(Command-1 ). Then switch back to the 
docume nt window and paste the ruler in 
(Command-2). Although this method only 
copies ruler settings (not font or style 
changes, for instance), it can still be a real 
time-saver. It also helps e nsure that your 
documents all have a uniform style . 

Later, if you want to change a particular 
format, you can use \VriteNow's identical 
ruler feature. just select the text from the 
first occurre nce of the format to the end 
of the document and then hold clown the 
Shift key while making the change in its 
ruler. 
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